(Jobs window only). You can remove this icon by
opening the job for editing.

Saved Packaging Hot Ticket (.pht)

A purple arrow is is attached to the Task
Processor icon if:

• You have a remote license. This means that
JOBList
LISTIcons
ICONS
Job
this Task Processor is not licensed to

Toolbar PREPRESS TOOLBAR
:APOGEE
Submit job or submit changes to a job.
Delete the selected item.

tasks: These tasks are processed
Jobexecute
group (based
on Order Number).
remotely on another :APOGEE Prepress
System. However, you can use this Task
Processor job
to specify
the settings Run
in theList.
Commercial
with incomplete
Production Plan.

• A remote proofer
is installed
(asRun
specified
Commercial
job with
complete
List. in
the installer). The remote proofer is
combined with the Remote Proofer
Controller
Task Processor.
Rush
job (Commercial
jobs only).

Edit Ticket.
View <selected item> (Job Ticket Editor only).
Make Blank (page in Run List - Job Ticket Editor
only).

Commercial job with disabled input channel.

OUTPUT TASK PROCESSOR HARDWARE
STATUS Commercial job is scheduled to be archived when

Give priority to processing the selected job
(Rush job).
Hold job, or put device offline (System
Overview).

Commercial The
job is
scheduled
be deleted
when it
Disconnected:
output
engine'stocable
has
is finished
(Options tab).
been
unplugged.

Continue processing <selected item>.
Reject <selected item>.

Icons Overview

Reprocess job from first.

Icons Overview
Re-image <selected item>.
Icons Overview

Page 1 of 13
Page 1 of 13

Enables the selected Hot Ticket (Hot Tickets
window only).
Disables the selected Hot Ticket (Hot Tickets
Icons Overview
window only).
Icons Overview
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Display information about <selected item>.

Icons Overview
Icons Overview

Marquee tool. Allows you to draw a rectangle in
JOB NOTIFICATION
ICONS
the Preview window
by clicking and dragging.
JOB NOTIFICATION
The :APOGEE
ink valuesICONS
for the selected
The
Prepress
systemregion
issuedare
a critical
measured
and Prepress
displayedsystem
in the Inks
palette.
The
:APOGEE
issued
a critical
system
message.

Job Notification Icons

system message.
Hand tool. Pans the image, allowing you to
The
has stopped
pending
viewjob
a page
that exceeds
theuser
size interaction.
of the
The
job has
stopped
pending
user
interaction.
Preview
window.
With
this tool
selected,
click

inside
window
and drag
the image
The
jobthe
hasPreview
generated
an error,
and has
stopped.
around.
The
job has generated an error, and has stopped.

The job has generated a warning.
Zoom
tool.
Zoomsain
to the next zoom
The
job has
generated
warning.
level in the remark:
Preview
window.
You
WebApproval
A remark
on this
jobcan
(or
zoom has
out been
by
holding
down
the
WebApproval
remark:
A remark
this Alt
job key.
(or
results)
received
from on
WebApproval.
results)
has been you
received
WebApproval.
Alternatively,
canfrom
click
and drag
The
job hasinto
generated
an information
to zoom
a specified
area. message.
The job has generated an information message.
Measure tool. Measures raster angles, and
distances between the raster points. You can
ICONS
(INCLUDING
PAGE STORE
JOB STATUS
also use
it to calculate
the line ruling
OB S)TATUS
ICONS
(INCLUDING
PAGEofSaTORE
JJOBS
separation.

Job
Status
Icons
JOBS
)

The
is being
archived
or dumped.
Nextjob
tool:
Displays
the next
side result (e.g.
The
jobSig
is being
archived
orSig
dumped.
Cover
1 Front
> Cover
1 Back > Cover
Sig 2job
Front
> Cover
Sig 2 from
Backarchive.
etc.). If you hold
The
is being
imported
down
‘C’ keyimported
while clicking
the tool,
The
jobthe
is being
from archive.
:APOGEE Prepress displays the next sheet
The
job(e.g.
is being
deleted.
result
Cover
Sig 1 Back > Cover Sig 2
The
job> is
beingSig
deleted.
Back
Cover
3 Back).
:APOGEE Prepress is queuing all commands for
:APOGEE
Prepress
is queuing
all commands
for
this
job.
Previous tool: Displays
the previous
side result.
this
job.hold down the ‘C’ key while clicking the
If you
tool,document
:APOGEEisPrepress
displays
previous
The
being edited
(it is the
‘checked
out’).
sheet
result. is being edited (it is ‘checked out’).
The
document
The job is being edited by another user.
Turn Sheet tool. If your results have 2 sides
The job is being edited by another user.
(front and back), Raster Preview can switch
The
Run List
is being
edited
another
user. to
between
the two
sides.
Clickby
this
tool (Ctrl-T)
The
Runthe
List
is being
by another
toggle
view
(front edited
or back).
This tooluser.
is
disabled
if the result
only contains one side.
You
are editing
the job.

You are editing the job.
Info tool. Display information about the selected
You
item.are editing the Run List.
You are editing the Run List.
Lightjob
Table
tool. Displays or hides blended front
The
is finished.
andjob
back
views of your raster data. This feature
The
is finished.
only works on the front and backs of the same
The
job was broken during editing. You can
signature/page.
The
job was
broken
editing.
can
remove
this icon
by during
opening
the jobYou
for editing.
remove
thistool.
iconDisplays
by opening
the job
for editing.
Rule-Ups
or hides
additional
The
jobofhas
been manually
on Raster
hold.
layers
information
on topput
of the
The
job has
beenThe
manually
putpalette
on hold.
Preview
image.
Rule/ups
contains a
The
output
is the
waiting
foryou
the can
correct
media to
tablejob
which
lists
layers
display.
The
job output
is waiting
for the correct media to
be loaded
on the
output device.
Rotate
clockwise
tool. Rotates
be
loaded
on the output
device. the current view
The
job is waiting
for a Task Processor (none
90 degrees
clockwise.
The
job isavailable).
waiting for a Task Processor (none
currently
Rotate counterclockwise
tool. Rotates the
currently
available).
Acurrent
group view
of results
is complete,
and is waiting to be
90 degrees
counterclockwise.
A
group(blue
of results
printed
icon).is complete, and is waiting to be
Flip vertical
printed
(blue tool.
icon).Flips the current view
vertically.
The
result is waiting for a hard proof.
The result is waiting for a hard proof.
Flip horizontal tool. Flips the current view
The
result is waiting for a web proof.
horizontally.
The result is waiting for a web proof.
The
jobtool.
is waiting
soft proof.
Invert
Invertsfor
thea current
view (negative).
The job is waiting for a soft proof.
A task has been aborted.
AColor
task Managed
has been aborted.
tool. Activates color-managed
raster
preview.
Thismanually
allows you
The
task
has been
putto
onpreview
hold. the
The task has been manually put on hold.
New (unplaced) documents are available in the
New
(unplaced)
documents are available in the
(Private)
Page Store.
(Private) Page Store.

The job is waiting for results.
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Commercial
is scheduled
to be archived
This
platesetterjob
is managed
by PlateRunner.
The and
yellow
‘sun’
patchit indicates
that(Options
the device
is in
deleted
when
is finished
tab).
attended state (i.e. A user is logged in to the
PlateRunner applicaton).
This platesetter is managed by PlateRunner. The
gray
‘moon’ patch
Packaging
job indicates that the device is in
unattended state (i.e. no one is logged in to the
PlateRunner applicaton).

Public Page Store job

Error: The hardware engine requires attention - it
cannot continue to receive and process tasks
until the problem has been resolved (e.g. no ink).

Icons Overview
HOT LIST ICONS

Page 11 of 13

Media: The icon is followed by a name: There is a

cassette in the tray but it is not loaded (not active).
However, it can be activated by :APOGEE
Prepress. If the name is in bold, the cassette is
loaded (active).
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Page 2 of 13

A green background color indicates that this flow
is currently active.
A blue background color indicates that this flow is

Page 3 of 13

A yellow background color indicates that this flow
contains tasks which are queued and waiting to
be processed.

A white background color with a green checkmark
indicates that this flow has finished.
Commercial Hot Ticket.
A red background color indicates that this flow has
Commercial
Ticket with a disabled input
generated
anHot
error.
channel.
A purple background color indicates that further
handling
of Hot
this Ticket
flow has been taken over by
Packaging
PlateRunner (Main flow only). For more details,
refer
to the Hot
PlateRunner
documentation.
Packaging
Ticket with
a disabled input
channel

FILTER BUTTONS
Flow
FLOWIcons
ICONS
Job Filter not applied.

Main Output: The default flow for all jobs, used for
output to a high resolution output device.
Job Filter applied.
Imposition Proof: An optional flow which may be
added to the Main Output flow, and is used for
output to an imposition proofing device.

FLOW CONTROL ACTIONS

Export: An optional or alternate flow to the Main
Output flow, used for exporting job results to file in
PDF or PostScript format.

05/19/2009

Public Page Store: An optional or alternate flow to
the Main Output flow, used for storing job results
in a Public Page Store.
Display: An optional or alternate flow to the Main
Output flow, used to create job results for highresolution soft proofing.

Media: There is no cassette in the tray.

Digital Quick Strip (DQS): An alternate mode of
operation which supports the PrintDrive DQS
mode of Apogee Series3. In this mode, :APOGEE
Prepress creates and renders the flat backgrounds and pages separately. These are then
sent as separate items to PrintDrive. PrintDrive
assembles the pages onto the backgrounds, and
then outputs the results as an integral job.

Media: There is an unknown problem with the tray.
Dedicated Resource linked uniquely to a specific
device: This Resource is not shared between
other devices of the same type.

:APOGEE PREPRESS ARCHIVE ICONS IN
WINDOWS EXPLORER

FLOW ICON COLOR CODING

Archived Commercial job (.arch)

A white background color indicates that this flow is
idle.

Archived Packaging job (.arch)

A green background color indicates that this flow
is currently active.

Archived Public Page Store job (.arch)

A blue background color indicates that this flow is
on hold.

:APOGEE PREPRESS TICKET ICONS IN
WINDOWS EXPLORER

A yellow background color indicates that this flow
contains tasks which are queued and waiting to
be processed.

Saved Commercial Job Ticket(.ajt)

A white background color with a green checkmark
indicates that this flow has finished.

Saved Commercial Hot Ticket(.aht)

A red background color indicates that this flow has
generated an error.

Saved Packaging Job Ticket (.pjt)

A purple background color indicates that further
handling of this flow has been taken over by
PlateRunner (Main flow only). For more details,
refer to the PlateRunner documentation.

Saved Packaging Hot Ticket (.pht)

:APOGEE PREPRESS TOOLBAR
Submit job or submit changes to a job.
Delete the selected item.

Job Filter not applied.

Page 7 of 13

have been fully rendered and are ready for
previewing or output. Visible for DQS and Raster
Impose
results
when you
choose View
>
RESULTS
- JOB
LAYOUT
ACTION
ICON> Show
STATUS
Page Rendered.
The page or flat has not yet reached this Action.
A small fold in a corner of a page indicates the
orientation.
Thehas
position
of the
tells(blue
you where
The
page or flat
reached
thisfold
Action
the top of the page is.The orientation of a page
background).
may vary in an imposition layout.
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The page or flat has passed this Action (dimmed
icon).

Production Plan contains an After Hours
ResultsThe– job’s
Separation/Composite
RESULTS
- SEPARATION
Action.
When this point/C
isOMPOSITE
reached, the job results
Indicators
in
a
regular
job
are heldIN(written
to disk)
pending
A NORMAL
JOB the specified
INDICATORS

time.
Square outlined separation indicator:
job’s Production
Plan contains
a Soft(itProof
•The
A process
color separation
is expected
has not
Action.
When
this point
reached,
theit job
results
yet been
rendered).
In is
this
example,
is the
are
held (written
to disk) pending
magenta
separation.
approval/rejection of a Digital Film preview by the
•user.
The background is available for an :APOGEE
Prepress DQS job.
The job’s Production Plan contains a Hard Copy
Square
solid separation
A process
Proof Action.
When thisindicator:
point is reached,
thecolor
job
separation
rendered,
is ready
for
results arehas
heldbeen
(written
to disk)and
pending
approval/
output.
In of
this
is theby
magenta
separation.
rejection
a example,
hard copyitproof
the user.

Icons Overview

Page 8 of 13

Checked
The separation
has
The job’sseparation
Productionindicator:
Plan contains
a Ready for
been
rendered,
and has
been
successfully
Plating
Action. When
this
point
is reached,output.
the job In
this
example,
it is the
separation.
results
are taken
overmagenta
and managed
by
PlateRunner (ready to plate).
Dimmed separation indicator: The separation has
been
discarded,
and will
notcontains
be output.
The job’s
Production
Plan
a Collect for
Output Action. When this point is reached, the job
Round outlined separation indicator: A spot color
results are held (written to disk) pending user
separation is expected (it has not yet been
intervention.
rendered). The outline color is the color of the
expected
color. Plan contains a Waiting for
The job’sspot
Production

file://D:\Program Files\A...
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Results Action. When this point is reached, the job
Round solid separation indicator: A spot color
results are held until the target flow or required
separation has been rendered, and is ready for
pages are finished.
output. The solid color is the spot color.
The job’s Production Plan contains a Discard
Checked separation indicator: The spot color
Action. When this point is reached, the job results
separation has been rendered, and has been sucare held until the specified pages have been
cessfully output.
automatically discarded.
The job’s Production Plan contains a Web Proof
Action.
this point/C
isOMPOSITE
reached, the job results
EPARATION
RESULTS
- SWhen
are held (written to disk) pending
IN
A
ERSIONING
JOBpreview by the
INDICATORS
V
approval/rejection of a Digital Film
remote user.
Process colors known but not rendered (round
separation indicators for spot colors).

RESULTS - JOB LAYOUT ACTION ICON STATUS

The page or flat has not yet reached this Action.
Process color plates from this version to be
output (round separation indicators for spot colThe page or flat has reached this Action (blue
ors).
background).
The page or flat has passed this Action (dimmed
icon). Process color plates from other version to be
remade for this version (round separation
indicators for spot colors).

RESULTS - SEPARATION/COMPOSITE
IN A N
ORMAL
INDICATORS
Process
color
platesJOB
from other version reused,
butoutlined
not remade
(roundindicator:
separation indicators for
Square
separation
spot colors).
• A process color separation is expected (it has not
yet been rendered). In this example, it is the
magenta separation.

Square solid separation indicator: A process color
separation has been rendered, and is ready for
Process
color plates
(but
not
output.
In this example,
it isfrom
the reused
magenta
separation.
remade) version output (round separation
indicators
for spot
colors).The separation has
Checked
separation
indicator:
been rendered, and has been successfully output. In
this example, it is the magenta separation.

Edit Ticket.

FLOW CONTROL ACTIONS

VERSIONING ICONS IN THE RESULTS TAB

Make Blank (page in Run List - Job Ticket Editor
only).
Give priority to processing the selected job
(Rush job).

Icons Overview

colorisplates
fromfor
this
made
• TheProcess
background
available
anversion
:APOGEE
(roundDQS
separation
Prepress
job. indicators for spot colors).

FILTER BUTTONS

Job Filter applied.

View <selected item> (Job Ticket Editor only).

The job’s Production Plan contains a Waiting for
Results Action. When this point is reached, the job
NDICATORS
RESULTSresults
- DATA
are Iheld
until the target flow or required
pages
are finished.
The
page/flat
belongs to a proofing workflow, and
is a composite TIFF file (i.e., not a separation). The
The job’s
Production
Plan contains
a Discard
page/flat
has
been rendered,
and is ready
for
Action. When this point is reached, the job results
output.
are held until the specified pages have been
automatically
discarded.
The
page/flat belongs
to a proofing workflow, and
is a composite TIFF file (i.e., not a separation). The
The
job’s
Production
Plan
contains
Web Proof
checkmark indicates that
it has
been a
successfully
Action. When this point is reached, the job results
printed.
are held (written to disk) pending
of aindicator
Digital Film
preview
by the
A approval/rejection
square gray-colored
in the
lower right
remote
corner
of user.
the page indicates that all separations

RESULTS - JOB LAYOUT ACTION ICONS

However, it cannot be activated by :APOGEE
Prepress (manual intervention on the engine is
required).
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The background and all version pages used by
the side are available, but the render data for the
whole side is not yet complete.

Error state: Processing of this side has been
stopped by an error.

Re-image <selected item>.

Process
colors
knownentered
but not rendered
(round
The
color is
was
manually
was found
in the
The color
directly
linked to the and
separation
indicators
for spotselected
colors).color
job.
The color is indirectly linked to the selected color.
The color is directly linked to the selected color
The
color was
found
in the
border
the imposition
Process
color
plates
from
this or
version
to be
The color is indirectly linked to the selected color.
template.

output (round separation indicators for spot colors).

The color
color was
was manually
found in the
borderwith
or the
imposition
The
entered,
marks.
template.
Mapped color name as defined by the Pantone
The
colorsettings.
was
manually
entered,
withversion
marks. to be
Process
color
plates from
other
mapping

remade for this version (round separation

Mapped
color
defined by the Pantone
indicators
forname
spotas
colors).
mapping settings.

IMPOSITION LINKED ICON

Indicates that this section is part of a multiple-section

Process color plates from other version reused,

signature.
IMPOSITION
INKED (round
ICON separation indicators for
but notLremade

spot colors).
Indicates
that this section is part of a multiple-section
signature.

MONITOR STATUS

The monitor status is up to date and the overall

display rating
is greater
than
90%
(Excellent).
Process
color plates
from
this
version
made
MONITOR
STATUS

(round separation indicators for spot colors).

The monitor status is up to date and the overall
display rating is greater
betweenthan
80%90%
and(Excellent).
90% (Medium).

The monitor status is up to date and the overall
Process
color plates
from80%
reused
(but (Medium).
not
display rating
is less
than
80%
(Bad).
between
and
90%

remade) version output (round separation
indicators
formonitor
spot colors).
There
is no
or it isand
outthe
of date
The monitor
status
isstatus,
up to date
overall
(Undefined).
display rating is less than 80% (Bad).

There is no monitor status, or it is out of date
(Undefined).

RIGIN IN THE RESULTS TAB
REMARK OICONS
VERSIONING

originated
the print
buyer.
Full Remark
bar at the
side offrom
the box:
A full
set of plates

Remark
Icons
will be
RIGINfor this side.
REMARK
Omade

Remark originated from the printer.

originated
buyer. set of
HalfRemark
bar at the
side offrom
the the
box:print
A partial
plates will be made for this version.
Remark originated from the printer.

REMARK
TYPE
One or
more version pages used by the side is
not yet
available (empty
placeholder).
An annotation
remark created
in PageMaster.

Click the associated (blue -encircled) annotation
REMARK
TYPEto jumpand
directly
to the referenced
location
Thenumber
background
all version
pages used
by

AnRaster
annotation
remarkbut
created
in PageMaster.
in
Preview.
the side
are available,
the render
data for the
Click
theisassociated
(blue -encircled) annotation
whole
side
not yet complete.
The
job has
been
approved
byreferenced
the corresponding
number
to jump
directly
to the
location

reviewer
(printer,
print buyer).
in Raster
Preview.
All render
data
for the
side is available, but not all
plates
have
yet
been
produced.
The job has been approved
by the corresponding
A general remark.
reviewer (printer, print buyer).

Finished state: All plates for the side have been
A page remark.
produced.
A general remark.
job has
been rejected
by side
the corresponding
ErrorThe
state:
Processing
of this
has been
A page remark.
reviewer
(printer,
stopped
by an
error.print buyer).
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Keep Result
(in
Run List
status column of versioning job). One
Archive
Result
or more pages in this row have a preflight report.
Clicking
Notify on the icon will bring up a menu which
Impose
results
whenofyou
> Show
contains
the titles
the choose
objects View
to which
the >
Page
Rendered.
preflight
reports are attached. Selecting one of the
Milestone
menu items opens the report in your PDF viewer.
A small fold in a corner of a page indicates the
orientation.
position
of the
fold The
tells page
you where
(in Run ListThe
status
column
of job).
has
the
top of /the
pageLis.The
orientation
of athe
page
generated
a UN
preflight
Clicking on
icon
PAGE S
TORE
R
ISTerror.
ICONS
may
vary inthe
anProblem
imposition
layout.
will open
Report.
PDF / PostScript composite document.
(in Run List status column of job). The page has
generated a preflight warning. Clicking on the icon
PDF
/ PostScript
composite
OB
AYOUT
CTIONpage.
RESULTSwill
- Jopen
Lthe
AReport.
ICONS
Problem
The job’s Production Plan contains an After Hours
Document
is this
being
edited
interactively
PDF /When
PostScript
pre-separated
document.
Action.
point
is reached,
the job results
within
usingthe
thespecified
Check-Out
are
held:APOGEE
(written toPrepress
disk) pending
plug-in
for
Acrobat.
time.
PDF / PostScript pre-separated page.

Results - Job Layout Action Icons

Document
has beenPlan
edited
interactively
The
job’s Production
contains
a Soft Proof
Raster
composite
document.
within
:APOGEE
Prepress
using the
Action.
When
this point
is reached,
theCheck-Out
job results
plug-in
Acrobat.
are
held for
(written
to disk) pending
approval/rejection
ofpage.
a Digital Film preview by the
Raster composite
user.

ICONS (VERSIONING
JOBS)
PDF LAYER
Raster
document.
The
job’s pre-separated
Production Plan
contains a Hard Copy

Proof
Action.
is reached,
the job
A single
PDFWhen
layer this
frompoint
a page,
without errors.
results
are
held (written page.
to disk) pending approval/
Raster
pre-separated
rejection
a hard
by the
A single of
PDF
layercopy
fromproof
a page,
withuser.
errors.
A red-colored icon indicates that the document or
The
job’s
Production
Plan
contains
a
Ready
for
been
processed
with errors.
Apage
singlehas
PDF
layer
from a page,
on hold before
Plating Action. When this point is reached, the job
reaching the Run List.
results
arewith
taken
overstripe
and managed
by the
An icon
a red
indicates that
PlateRunner
(ready
to
plate).
or
pagefrom
has
been
rejected.
Adocument
single PDF
layer
a page,
which has been
rejected.
The
job’s Production
contains
Collect
for or
A blue-colored
iconPlan
indicates
thatathe
document
Output
When this point is reached, the job
page Action.
is on hold.
results are held (written to disk) pending user
intervention.
EXTENDED
PAGE
ADJUSTMENT
ICONS
A Public
Page
Store (Page Store
only).
The job’s Production Plan contains a Waiting for
EmptyAction.
placeholder
List only).
Results
When(Run
this point
is reached, the job
Rotate
resultsCenter
are heldOffset
until theScale
target flow
or required
pages
finished.
Blankare
page
(Run List only).
Horizontal
The
job’s
Production
Plan
a Discard
Job
processing
is not
yetcontains
complete
in the
When Plan
this point
is the
reached,
the job results
Vertical Action.
Production
before
Run List.
are held until the specified pages have been
discarded.
Both automatically
Unknown document.
The job’s Production Plan contains a Web Proof
Page When
imposition
has been
adjusted
List
Auto-center
Action.
this point
is reached,
the(Run
job results
only).
are
held (written to disk) pending
approval/rejection of a Digital Film preview by the
90
(in Run
List status column of normal job). The
remote
user.
page has a preflight report. Clicking on the icon
180
will open the report in your PDF viewer.

The job
has Processing
been rejectedofbythis
theside
corresponding
On Hold
state:
is waiting at

OB List
RESULTS
- JRun
LAYOUT
ACTION
ICON STATUS
270
(in
status column
of versioning
job). One

This side or one of its separations or pages has

Results – Job Layout Thumbnails

reviewer (printer, print buyer).

hold
point.
ROCESSOR
TASKa P
COLOR CODING

TASKbeen
PROCESSOR
rejected. COLOR CODING
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or more pages in this row have a preflight report.
The page or flat has not yet reached this Action.
Clicking on the icon will bring up a menu which
contains the titles of the objects to which the
The page
or flat
has reached
this Action (blue
RESULTS
- JOB
LAYOUT
THUMBNAILS
background).
The page or flat has passed this Action (dimmed
icon).
A thumbnail view of this page is either
not available, or is currently being
retrieved from the :APOGEE Prepress
System (green background color).
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RESULTS - SEPARATION/COMPOSITE
INDICATORS IN A NORMAL JOB
Square outlined separation indicator:

• A process color separation is expected (it has not
yet been rendered). In this example, it is the
magenta separation.
Page has been processed successfully
• The background
is available
for an :APOGEE
(no background
color).
Prepress DQS job.
Square solid separation indicator: A process color
separation has been rendered, and is ready for
output. In this example, it is the magenta separation.
Checked separation indicator: The separation has
been rendered,
and
has
been
successfully
output. In
Page
has
been
processed
successfully,
this example,and
it isisthe
separation.
on magenta
hold pending
approval (blue
background color).
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Page has been processed with errors
(red background color).

Page is managed by thePage
PlateMaker
Icons Overview
5 of 10
Client, and is ready to plate (purple
background color).

Page has been processed successfully,
but has been rejected.
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On Hold state: Processing of this side is waiting at
a hold point.

05/19/2009

This side or one of its separations or pages has
been rejected.

file://D:\Program Files\A...

The
job. color was manually entered.

RESULT
ACTIONS
Result
Actions
Icons
Overview

All render data for the side is available, but not all
plates have yet been produced.
Finished state: All plates for the side have been
produced.

Reprocess job from first.

Results – Separation/Composite

was manually
entered.
EPARATION
OMPOSITE
RESULTSThe
- Scolor
/Cthe
The
color
found in
job.
Indicators
in
aAwas
Version
job
IN
ERSIONING
JOB
INDICATORS
V
The color was manually entered and was found in the

Page 4 of 10

Half bar at the side of the box: A partial set of

Resume a job on hold, or put device online
(System Overview).

Reject <selected item>.

The color
color was
definition
found
The
foundwas
in the
job.in the :APOGEE
Prepress Color Books.

After Hours

Icons Overview

Files\A...
file://D:\Program
05/19/2009
plates will be made
for this version.
One or more version pages used by the side is
not yet available (empty placeholder).

Continue processing <selected item>.

Checked
The
spot
color
The -color
definition indicator:
was
in S
the
:APOGEE
EPARATE
OLOR
EPARATION
RENDER
Sseparation
- Cfound
separation
been
rendered, and has been sucPrepresshas
Color
Books.
ICONS
cessfully output.

Full bar at the side of the box: A full set of plates
will be made for this side.

Hold job, or put device offline (System
Overview).

Not all the results of a group are yet available
(green icon).

Files\A...
file://D:\Program
05/19/2009
The job is waitingFiles\A...
for After Hours processing.
file://D:\Program
05/19/2009

A white background color indicates that this flow is
idle.

file://D:\Program Files\A...

results are held (written to disk) pending user
intervention.

Results – Proofing Data Indicators

Page Proof: An optional flow which may be added
to the Main Output flow, and is used for output to
a page proofing device.

Resource
Icons
TATUS ICONS
RESOURCE SStatus

Media: The icon
is followed by a05/19/2009
name: There is a
file://D:\Program
Files\A...
cassette in the tray but it is not loaded (not active).

PREVIEW PALETTE TOOLS

Icons Overview

Warning: The hardware engine requires attention
Commercial job has been deleted.
(e.g. ink low), but can still receive tasks.

Commercial job has been archived and deleted.
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Flow
FLOWIcon
ICON Color
COLORCoding
CODING

on hold.
Icons Overview

it is finished
(Options
tab).
Paused:
The output
engine
is able to
communicate, but cannot process any tasks. A
user
interactionjob
hashas
taken
place
on the device
Commercial
been
archived.
itself to trigger this status.

Resume a job on hold, or put device online
(System Overview).

assembles the pages onto the backgrounds, and
then outputs the results as an integral job.

Page has been discarded.

05/19/2009

Some results have been rejected by the user.
The imposition is not yet defined.

file://D:\Program Files\A...

05/19/2009

The job has reached a Milestone: The Run List is
not complete. This Milestone was set up in the
Options tab.

An empty page in the Run List (white
background with a cross).

The job has reached a Milestone: The job
deadline has been reached. This Milestone was
set up in the Options tab.
The job has reached a Milestone: The result is not
available in time. This Milestone was set up using
a Milestone Action in the Production Plan.

A blank page in the Run List (white
background).

The job is managed by :APOGEE Prepress
PlateRunner (ready to plate). PlateRunner will
take care of further plate production.

RESULTS - DATA INDICATORS

JOB STATUS ICONS IN TAB AREA (JTE ONLY)

The page/flat belongs to a proofing workflow, and
is a composite TIFF file (i.e., not a separation). The
page/flat has been rendered, and is ready for
output.

The job is being viewed by you or by another user
(JTE only).
The job is being edited by another user.
You are editing the job.
The selected job was being edited by you or by
another user, but the edit session was broken
(Jobs window only). You can remove this icon by
opening the job for editing.

JOB LIST ICONS
Job group (based on Order Number).

Job List Icons

The page/flat belongs to a proofing workflow, and
is a composite TIFF file (i.e., not a separation). The
checkmark indicates that it has been successfully
printed.
A square gray-colored indicator in the lower right
corner of the page indicates that all separations
have been fully rendered and are ready for
previewing or output. Visible for DQS and Raster
Impose results when you choose View > Show >
Page Rendered.
A small fold in a corner of a page indicates the

Controller Task Processor.

Display information about <selected item>.

OUTPUT Task
TASK Processor
PROCESSORHardware
HARDWARE
Output
Status

Preview
Palette
Tools
PREVIEW
PALETTE
TOOLS

STATUS

Marquee tool. Allows you to draw a rectangle in
the Preview window by clicking and dragging.
The ink values for the selected region are
measured and displayed in the Inks palette.

System Overview

Hand tool. Pans the image, allowing you to
view a page that exceeds the size of the
Preview window. With this tool selected, click
inside the Preview window and drag the image
around.

Paused: The output engine is able to
communicate, but cannot process any tasks. A
user interaction has taken place on the device
itself to trigger this status.
Disconnected: The output engine's cable has
been unplugged.
Warning: The hardware engine requires attention
(e.g. ink low), but can still receive tasks.

Zoom tool. Zooms in to the next zoom
level in the Preview window. You can
zoom out by holding down the Alt key.
Alternatively, you can click and drag
to zoom into a specified area.

This platesetter is managed by PlateRunner. The
yellow ‘sun’ patch indicates that the device is in
attended state (i.e. A user is logged in to the
PlateRunner applicaton).

Measure tool. Measures raster angles, and
distances between the raster points. You can
also use it to calculate the line ruling of a
separation.

This platesetter is managed by PlateRunner. The
gray ‘moon’ patch indicates that the device is in
unattended state (i.e. no one is logged in to the
PlateRunner applicaton).

Next tool: Displays the next side result (e.g.
Cover Sig 1 Front > Cover Sig 1 Back > Cover
Sig 2 Front > Cover Sig 2 Back etc.). If you hold
down the ‘C’ key while clicking the tool,
:APOGEE Prepress displays the next sheet
result (e.g. Cover Sig 1 Back > Cover Sig 2
Back > Cover Sig 3 Back).

Error: The hardware engine requires attention - it
cannot continue to receive and process tasks
until the problem has been resolved (e.g. no ink).

Icons Overview
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RESOURCE STATUS ICONS

Task Processor
Color Coding
Media: The icon is followed by a name: There is a

Previous tool: Displays the previous side result.
If you hold down the ‘C’ key while clicking the
tool, :APOGEE Prepress displays the previous
sheet result.

The Task Processor is ready, and is currently
idle.

Turn Sheet tool. If your results have 2 sides
(front and back), Raster Preview can switch
between the two sides. Click this tool (Ctrl-T) to
toggle the view (front or back). This tool is
disabled if the result only contains one side.

The Task Processor turns green when it is

processing a task.
For example, the
Avantra
Files\A...
file://D:\Program
05/19/2009
Task Processor is busy processing a
separation.

Info tool. Display information about the selected
item.

The Task Processor turns red if a processing
error occurs. In this case an error notification
is sent to the Message Board, explaining the
nature of the error.

Light Table tool. Displays or hides blended front
and back views of your raster data. This feature
only works on the front and backs of the same
signature/page.
Rule-Ups tool. Displays or hides additional

Icons Overview
4 of 13
The Task Processor turns blue ifPage
it is offline.

of information on top of the Raster
Iconslayers
Overview
Page 9 of 13
Preview image. The Rule/ups palette contains a
table which lists the layers you can display.

When the Task Processor has been stopped
(inactive), the icon will have horizontal stripes
running through it. You can re-activate it by
context-clicking
on the icon and selecting Start
Discard
from the context menu.

Rotate clockwise tool. Rotates the current view
90 degrees clockwise.
Rotate counterclockwise tool. Rotates the
This side has been discarded and will not be
current view 90 degrees counterclockwise.
processed further.
Flip vertical tool. Flips the current view
vertically.

Wait for Results
The Task Processor is starting up (moving
horizontal
Web Proofstripes).

RENDER
- SEPARATE - COLOR SEPARATION
Flip horizontal tool. Flips the current view
ICONShorizontally.

Icons Overview
Page 13 of 13
The color definition was found in the :APOGEE

Soft Proof
The Task Processor is locked, because you do
not
have
a license
Hard
Copy
Proof to use it.

Prepress
Books.
Invert tool.Color
Inverts
the current view (negative).
The color was found in the job.
Color Managed tool. Activates color-managed
raster
preview.
This allows
you to preview the
The
color
was manually
entered.

Collect
Output
A
purplefor
arrow
is is attached to the Task
Processor icon if:

rendered result using color management to
convert
colorentered
space and
to the
monitor
The
colorthe
waspress
manually
was
found in the
color space (based on ICC profiles).
job.

•After
YouHours
have a remote license. This means that
this Task Processor is not licensed to
execute tasks: These tasks are processed
remotely on another :APOGEE Prepress
RESULT ACTIONS
System. However, you can use this Task
Processor to specify the settings in the
Keep
Result Plan.
Production

Show/Hide
rulers tool.
ruler
The
color is directly
linkedShows/Hides
to the selected
color

coordinates in the units set in your Preferences.
Files\A... 05/19/2009
file://D:\Program
The
color is indirectly
to the selectedgridlines
color.
Show/Hide
gridlineslinked
tool. Shows/Hides

for every major and minor division of the ruler.

The
wassetting
found in
border in
oryour
the imposition
Thecolor
default
is the
specified
template.
Preferences.

Raster Preview

• A remote
proofer is installed (as specified in
Archive
Result
the installer). The remote proofer is
combined with the Remote Proofer
Notify
Controller Task Processor.

The
color was
entered,
with marks.
Approve
tool.manually
Approves
a previewed
result.

This tool is disabled if no soft preview has been

Mapped
color name as defined by the Pantone
requested.
mapping settings.

Milestone

OUTPUT TASK PROCESSOR HARDWARE
STATUS
List
PPage
AGE SStore/Run
TORE / RUN L
IST IIcons
CONS

Reject tool. Rejects a previewed result. This
tool is disabled if no soft preview has been
requested.
IMPOSITION
LINKED ICON

Paused: The output engine is able to
PDF / PostScript
composite
document.
communicate,
but cannot
process
any tasks. A
user interaction has taken place on the device
itself
trigger this composite
status.
PDFto/ PostScript
page.

Indicates that this section is part of a multiple-section
signature.

OTHER BUTTONS

Monitor
Status
Task
TATUS Settings lock.
MONITOR
SProcessor

Disconnected: The output engine's cable has
PDFunplugged.
/ PostScript pre-separated document.
been

The monitor status is up to date and the overall
Edit
display rating is greater than 90% (Excellent).

Warning:
The hardware
engine requires
PDF / PostScript
pre-separated
page. attention
(e.g. ink low), but can still receive tasks.

Icons Overview
Page
13overall
of 13
The monitor status is up to date
and the
displayNew
rating is between 80% and 90% (Medium).
Create
The monitor status is up to date and the overall
display rating is less than 80% (Bad).
Delete

Run List

There is no monitor status, or it is out of date

(Undefined).
rendered
result using color management to
Set
as default
convert the press color space to the monitor
color space (based on ICC profiles).
Duplicate
REMARK
ORIGIN
Show/Hide rulers tool. Shows/Hides ruler
Remark
originated
from the
buyer.
coordinates
in the units
set print
in your
Preferences.
Export
Show/Hide
gridlines
tool.
Shows/Hides
gridlines
Remark originated
from the printer.
Commercial
Hot Ticket.
for every major and minor division of the ruler.
Import
The default setting is specified in your
Commercial Hot Ticket with a disabled input
Preferences.
channel.
Auto-fill
REMARK
TYPE(Versioning): Automatically fills the
version
table
with a
the
names ofresult.
the PDF
Approve
tool.either
Approves
previewed
An annotation remark created in PageMaster.
layers
or the
names
of
thesoft
documents
in the
Packaging
Hot
Ticket
This
isassociated
disabled
if(blue
no
preview
has
been
Clicktool
the
-encircled)
annotation
Page
Store.
requested.
number
to jump directly to the referenced location
Packaging
Hot Ticket with a disabled input
in Raster Preview.
Reject
tool. Rejects a previewed result. This
channel
Insert
variable
tool
disabled
if no
soft preview
been
Theisjob
has been
approved
by thehas
corresponding
requested.
reviewer (printer, print buyer).

Icons Overview
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Hot Ticket List Icons

Media:
The Page
icon isStore
followed
byStore
a name:
There is a
A Public
(Page
only).
Empty placeholder (Run List only).
Blank page (Run List only).

FLOW ICONS
A general remark.

Job processing
is not yet complete
in the
Files\A...
file://D:\Program
05/19/2009
Production Plan before the Run List.

output
a high resolution output device.
A
page to
remark.

Unknown document.

Task Processor Settings lock.
Imposition
An optional
flow
which may be
The
job hasProof:
been rejected
by the
corresponding
added to(printer,
the Main
Output
flow, and is used for
reviewer
print
buyer).
output to an imposition proofing device.
Edit

Page imposition has been adjusted (Run List
only).

Page Proof: An optional flow which may be added
TASK PROCESSOR
COLOR
CODING
Create
New Output
to the Main
flow, and is used for output to

(in Run List status column of normal job). The
page has a preflight report. Clicking on the icon
will open the report in your PDF viewer.

Icons Overview

a page proofing device.

Delete
Export: An optional or alternate flow to the Main
Output flow, used for exporting job results to file in
PDF or PostScript format.
Set as default
Public Page Store: An optional or alternate flow to

(in Run List status column of job). The page has
generated a preflight error. Clicking on the icon
will open the Problem Report.

Files\A... 05/19/2009
file://D:\Program
(in Run List status column of job). The page has

Hot Tickets

generated a preflight warning. Clicking on the icon
will open the Problem Report.
Document is being edited interactively
within :APOGEE Prepress using the Check-Out
plug-in for Acrobat.
Document has been edited interactively
within :APOGEE Prepress using the Check-Out
plug-in for Acrobat.

FLOW ICON COLOR CODING

Files\A...
file://D:\Program
05/19/2009
A white background
color indicates
that this flow is

PDF LAYER ICONS (VERSIONING JOBS)

idle.

A blue background color indicates that this flow is
on hold.
A yellow background color indicates that this flow
contains tasks which are queued and waiting to
be processed.
A white background color with a green checkmark
indicates that this flow has finished.
A red background color indicates that this flow has
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(in Run List status column of versioning job). One
or more pages in this row have a preflight report.
Clicking on the icon will bring up a menu which
contains the titles of the objects to which the
preflight reports are attached. Selecting one of the
menu items opens the report in your PDF viewer.

the Main OutputFiles\A...
flow, used for storing
job results
file://D:\Program
05/19/2009
Duplicate
in a Public Page Store.

A green background color indicates that this flow
is currently active.

Raster
pre-separated
document.
This
platesetter
is managed
by PlateRunner. The
gray ‘moon’ patch indicates that the device is in
Raster pre-separated
unattended
state (i.e. nopage.
one is logged in to the
PlateRunner applicaton).
A red-colored icon indicates that the document or
Error:
engine with
requires
attention - it
pageThe
has hardware
been processed
errors.
cannot continue to receive and process tasks
until
hasstripe
beenindicates
resolvedthat
(e.g.the
no ink).
An the
iconproblem
with a red
document or page has been rejected.
A blue-colored icon indicates that the document or
RESOURCE
STATUS ICONS
page is on hold.

Main Output: The default flow for all jobs, used for
THER BButtons
UTTONS
OOther

Display: An optional or alternate flow to the Main
Export
Output flow, used to create job results for highresolution soft proofing.
Import
Digital Quick Strip (DQS): An alternate mode of
operation which supports the PrintDrive DQS
Auto-fill (Versioning): Automatically fills the
mode of Apogee Series3. In this mode, :APOGEE
version table either with the names of the PDF
Prepress creates and renders the flat backlayers or the names of the documents in the
grounds and pages separately. These are then
Page Store.
sent as separate items to PrintDrive. PrintDrive
assembles the pages onto the backgrounds, and
Insert
variablethe results as an integral job.
then outputs

Raster
composite
document.
This
platesetter
is managed
by PlateRunner. The
yellow ‘sun’ patch indicates that the device is in
attended
state (i.e. A
user is logged in to the
Raster composite
page.
PlateRunner applicaton).

Additional Icons

A single PDF layer from a page, without errors.
A single PDF layer from a page, with errors.
A single PDF layer from a page, on hold before
reaching the Run List.
A single PDF layer from a page, which has been
rejected.

EXTENDED PAGE ADJUSTMENT ICONS

